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[bookmark: _k8by73tfx1v8]Protomax
[bookmark: _oqzkdzo5b6fy]Author: 
Constantine
[bookmark: _d958haywl9v2]Name of Machine: 
ProtoMax

[bookmark: _sdfzknpsvxzk]Link to Manufacturer’s Manual:
https://www.protomax.com/specsheet/ProtoMAX-Technical-Specsheet.pdf 

[bookmark: _mihsgcoiud2]3 Sentence Description:
The ProtoMax is a compact waterjet capable of cutting virtually any material by shooting a stream of water mixed with abrasive. Typically, it is used to cut metals, but plastics or ceramics can be cut as well. Waterjets are great for cutting sheets of material from a drawing. Another benefit of waterjets is that it can cut materials that are sensitive to high temperatures.  
[bookmark: _p8z1abpp357i]Physical Limitations:
· Maximum Material Size: 12x12 in
· Maximum Material Thickness: 1 in
· Output Pressure: 30,000 psi
· Feed Rate: 100 in/min
· Positional Accuracy: ±.005 in
· Maximum Material Load: 50 lbs/sq ft
· Kerf: .015 in
[bookmark: _4scurzcdb1or]Materials:
The ProtoMax can cut a wide variety of materials, which include:
· Aluminum
· Steel
· Carbon Fiber
· Acrylic
· Fiberglass
· Foam
Glass is specifically prohibited, as the ProtoMAX does not have a low pressure setting appropriate for cutting brittle materials.

[bookmark: _gnhd74f1mboa]PPE:
Safety glasses and closed toe shoes are required to operate the ProtoMax waterjet. 

[bookmark: _iargqekdhd76]E-Stops and Safety Procedures:
When the lid is open, the waterjet will only be able to traverse or run a dry run. All controls are found in ProtoMax Make. Make sure the nozzle has a clear path to traverse before moving it. Keep hands clear of the work area when moving the nozzle. Try to keep parts submerged to prevent splashing on the lid. 

[bookmark: _5ir93recj5op]Startup Procedure:
1. Turn on Laptop
2. Connect the USB from the ProtoMax to the computer.
3. Turn the main breaker to the on position on the right side of the waterjet.
4. Turn the water supply valve to the open position (it should already be open).
5. Make sure the pressure gague on the right side of the waterjet reads 60psi.
6. Open ProtoMax Make.
7. Follow directions on the screen to perform the initial homing procedure. 
8. Make sure the garnet hopper is filled. If not, fill the hopper. 
[bookmark: _ytlp4pw7p23h]Operation:
1. Place workpiece in the waterjet. 
2. Clamp the workpiece down using clamping techniques. 
3. Set the z-axis by unfastening the knob on the nozzle, move the nozzle up or down to fit the measuring plate, then re-lock the nozzle. 
4. Load the waterjet file in ProtoMax Make.
5. Set homes for the cut.
6. Flip the plastic guard on the nozzle to the down position. 
7. Raise the water level to just above the workpiece. 
8. Close lid.
9. Start the cut in ProtoMax Make.
10. When the cut is completed, traverse the nozzle away from the workpiece.
11. Remove the part from the waterjet. 
[bookmark: _lb5vfv3pa3n1]Recommended Clean-Up:
After using the waterjet, make sure the nozzle is at its highest position and there is no material in the waterjet. Empty the garnet reservoirs if they are full and spray down the inside of the waterjet. The waterjet should be clean for the next user. 

[bookmark: _vbjatf2tibof]References:


[bookmark: _1p8ds8fewyji]OMAX Maxiem 1515
[bookmark: _2xfpg7nj2tpl]Author: 
Miles
[bookmark: _y9f2eqkoaxzn]Name of Machine: 
OMAX Maxiem 1515

 
Image Source: OMAX

[bookmark: _bbts0c1di2gm]Link to Manufacturer’s Manual:
https://www.omax.com/sites/default/files/media/specsheets/600101g_-_1515.pdf
This is a brief overview manual, as the full-length manual is proprietary and not available online. A paper copy of the full manual is available in the waterjet cabinet.

[bookmark: _t3x84oh63bi4]3 Sentence Description (Explain Like I'm 5):
The OMAX Maxiem 1515 is capable of cutting complicated contours in a wide variety of materials using a high pressure stream of water and garnet abrasive. It includes advanced features such as the 5 axis cutting head for cutting tapered parts, low pressure settings for brittle materials, as well as etching and scribing settings. Other accessories include rapid water level adjustment and automatic garnet feed from an external reservoir.

[bookmark: _cumejb7crjk]Physical Limitations:
· Kerf size is 0.021 in.
· Maximum material horizontal dimensions are slightly less than 5 ft. 2 in. by 5 ft. 2 in. (bed size)
· Maximum material height is slightly less than 12 in. (z axis travel)
· Capable of cutting through up to 6” thick mild steel
· Maximum supported material load 300 lb./ft.^2
· Maximum Speed 500 in./min
· Linear positional accuracy: +/-0.0030 in.
· Repeatability: +/-0.0010 in.
· Ballbar Circularity: +/-0.0050 in.
[bookmark: _qxwlh9prv5ie]Materials:
· Metal
· Wood
· Plastic
· Ceramics
· Porcelain
· Glass

[bookmark: _yr76qalofcjs]PPE:
Safety glasses and close-toed shoes are required when operating the waterjet. Ear protection is optional as the piercing phase of the cut can be loud

[bookmark: _68f4x7ia58ag]E-Stops and Safety Procedures:
The main E-stop is a large red button located on the right side of the computer cart. Pushing the E-stop will stop all water flow and powered motion. The nozzle will descend, as the z-axis actuator will be unpowered. 

Jobs can also be instantly paused by hitting the spacebar or clicking the pause button in the cut dialog on the computer screen.

Never place hand near cutting head. Always check the entire cut envelope for collisions with weights, clamps, and other obstacles before starting a cut, as detailed in the Operating Equipment section.

[bookmark: _aahn8153fdm0]Project Ideas (with links to content):
· Race car front splitter, brake pedal brace
· https://waterjets.org/archive/parts-made-by-waterjets/fun-parts/race-car-parts/
· Wooden electric guitar
· https://waterjets.org/archive/parts-made-by-waterjets/fun-parts/wooden-electric-guitar/
· Half-Life 2 Logo
· https://waterjets.org/archive/parts-made-by-waterjets/fun-parts/half-life-2-logo/
· Cutting glass plate with bolt pattern and cutout
· https://youtu.be/b0prSmI2zZs
· Great example of waterjet brick usage
· Cutting bicycle pattern from ceramic tile
· https://youtu.be/5E4pxS22NlY
· Note usage of perforated, waterjet brick-like sacrificial material below the material being cut
· Marble tile carpets
· https://youtu.be/hpiMTM8K4WA
· Waterjet ability to cut intricate pieces of marble allows the creation of beautiful tiled patterns
· Cutting porcelain tile
· https://youtu.be/Ws0Jmh3Re30


[bookmark: _o080phg9d1vw]Startup Procedure:
1. Flip main breaker (1) up to “On” position.
2. Turn water and air valves (2) and (3) to open position (levers parallel to desired flow)
3. Turn switch 4 to “On” position
4. Turn switch 5 to “On” position
5. Turn switch 6 to “On” position to supply power to computer
6. Verify that the monitor is on
7. Verify that the computer is on
8. Press power buttons on monitor and computer as necessary
[bookmark: _25ux855r5ikh]Operation of Equipment:

Sign In
Use your buzz card at the SUMS terminal to log into the OMAX Maxiem

Secure material to be cut on slats
1. For more details see article: Hold Down Techniques
2. Open OMAX Make and move the waterjet nozzle out of the way
3. If the waterjet brick or other sacrificial material is required (an example would be for cutting a small piece of brittle glass)
a. Place sacrificial material on the slats
b. Secure sacrificial material using weights, side clamps, and vertical clamps as appropriate
c. Secure the material to be cut to the sacrificial material using nails and move directly to step 4
4. For most materials, place the material directly on the slats and secure using weights, side clamps, and vertical clamps as appropriate
5. Check to ensure that the material to be cut cannot be moved side to side easily by hand.
6. Verify that the material cannot bow up and down, particularly if thin. 
a. A possible hazard is the material vibrating during the cutting operation and striking the mixing tube (end of the nozzle), which can cause serious damage
b. Reduce the amount of material free to bow and vibrate through strategic placement of weights and smart cut path design in OMAX Layout


Prepare Toolpath
Follow the OMAX Layout procedure to set up the cutting path. See article: Omax Layout

Send Job to OMAX Make
Material properties are defined in this step. See article: Omax Make

Defining Initial Z-Zero
1. Raise the Z height an inch above the material
2. Move nozzle to somewhere near the desired X-Y path start location 
3. Place height gauge below nozzle and wiggle it back and forth, but not up and down
4. While wiggling the height gauge, move the nozzle down using the Fine Adjust keys (Home and End for up and down) until slight friction is felt between the height gauge and nozzle tip
5. For more details, consult OMAX Make guide
6. Then, tap the Home key once to raise the nozzle slightly so there is no friction
7. Raise the nozzle a few taps if cutting material that is particularly thin, to avoid touching the material if it vibrates.
8. Set this location as the Z-Zero “Home” per the OMAX Make guide

Defining X-Y Zero
1. Move nozzle to desired X-Y zero location
2. Set this location as the X-Y zero “Home” per the OMAX Make guide

Checking Cut Envelope
It is important to check the maximum extent of the cut envelope for:
· Collisions with high spots in the material 
· Collisions with weights, clamps, and other obstacles
· Ensuring that there is sufficient material available to do the job

Failure to perform this check is irresponsible. If a collision occurs the machine calibration can be upset, and the machine can be damaged. Please make sure to always check your cut envelope using the following steps
1. Identify under part statistics the maximum height and width of your cut. 
2. Using the arrow keys, move the nozzle along the bottom edge of cut envelope while periodically pausing to check the distance between the nozzle and material using the height gauge. Watch out for obstacles.
3. If the nozzle is too close to the material at any point, raise the Z axis and set the new Z position as the Z “Home”
4. Repeat this process for the right, top, and left edge.
5. If a collision is a risk at any point, alter the X-Y Home position to shift the cut path away from the problem, and start the checking process again.
6. Check a few points in the interior of the cut envelope with the height gauge.
7. It is okay to use “Go to Spot on Path” and “Dry Run” functions to perform additional validation as needed. 
8. Cutting jobs may be performed after this check process is completed.

 
Adjusting Water Level
1. The water level adjustment lever is located on the right side of the waterjet computer stand. It controls the air in the ballast tank at the rear of the waterjet. The air in the ballast tank pushes on the water in the tank to regulate the water level.
2. To raise water level, pull lever upwards
3. To lower water level, push lever downwards


Running Job
1. Move nozzle to job start position 
2. Verify nozzle is at correct starting height
3. Visually verify that cutting profile is clear of clamps, weights, and other obstructions
4. Lower yellow splash guard if in use
5. Click “Begin Machining”
6. Click the “Play” button
7. The job percentage completed is displayed on the screen. Hitting the space bar pauses the job if needed.


Recommended Clean-Up:

Cleaning Work Area
1. Move nozzle out of the way
2. Rinse parts and scrap material with the water hose over the waterjet tank
3. Dry parts and scrap material with the compressed air gun over the waterjet tank
4. Remove parts and scrap material from waterjet tank
5. Secure parts. If discarding scrap material, place usable scrap in the scrap rack, and throw unusable scrap in the trash container downstairs by the loading dock.
6. Lower the water level to just below the top of the slats
7. Using the water hose, spray down the L-bracket to remove garnet build up
8. Spray down covers to remove garnet splatter
9. Mop up any spilled water, wipe off any splatter from surrounding areas


Closing Software
1. In Make, go to “History” in the top bar, and select “Counters/Timers”
2. The “Total Hours on Pump” value should be recorded on the waterjet logout screen at the SUMS terminal
3. Close OMAX Layout and Make
4. Remove USB drive from computer
 
Shutting Down Waterjet
1. Shut down power to computer by turning switch 6 to “Off” position
2. Turn switch 5 to “Off” position
3. Turn switch 4 to “Off” position
4. Turn air and water valves 3 and 2 to “Off” position (levers perpendicular to flow)
5. Pull main breaker (1) down to “Off” position


Sign out
Sign out on the SUMS terminal. This is where the pump hours number you recovered will be used. Do not forget your USB drive and parts.

Basic Troubleshooting:
· Water level will not decrease sufficiently
· Raise water level to maximum height, so excess water can flow down drain (behind the tank
· Once excess water has exited the tank, lowering the water level will have a larger effect
· Waterjet is not cutting through material
· A clog in the tube between the garnet hopper and nozzle is likely
· Disconnect the feed tube from the garnet hopper and nozzle
· Secure both ends of the feed tube and blow compressed air through the tube until the tube is cleared and dry
· Reconnect the feed tube to the garnet hopper and nozzle 
· Another possible cause is a problem in the valve which controls garnet flow below the garnet hopper
· Inform the waterjet master
· Water is not flowing during job
· Check screen on pump unit. Hit “Reset” if there is a fault.
· Move nozzle back to path start position and restart cut.
· Contact waterjet master if problem remains unresolved.


Advanced Troubleshooting/Maintenance:
●	Clearing the clogged garnet flow valve underneath the garnet hopper	Comment by Veronica Spencer: Masters only - not going on the website
○	Disconnect the feed tube from the garnet hopper
○	Run an abrasive only test to verify the garnet flow valve functionality
○	If garnet is not flowing freely, run the abrasive only test again and try to clear out the valve with compressed air while it is open
○	Afterwards, remember to reconnect the feed tube to the garnet hopper
●	Pump pressure may need to be adjusted periodically to its nominal 45000 psi on high pressure and 22000 psi on low pressure
○	To adjust the pressure, access the yellow adjustment wheel, unscrew the locking wing nut, and turn the wheel. Tighten the locking wing nut when the display shows the desired pressure
○	Consult MAXIEM manual for additional information

References
OMAX. (n.d.). MAXIEM 1515. Retrieved on July 8, 2018. https://www.omax.com/maxiem-waterjet/1515




[bookmark: _kc0f0y1yc1qo]Flow
[bookmark: _w23fe5ie5iwn]Author: 
Sid
[bookmark: _21l9jgamv24o]Name of Machine :  
Flow Bengal 016670-1
[bookmark: _yswkm1cm7dxl]Link to Manufacturer's Manual:
https://drive.google.com/open?id=1zQ9RbXFF3wgX_O94ABPECD-RJ2QqZUta 

[bookmark: _n1gc1376k48]3 Sentence Description (Explain Like I'm 5):
The Flow waterjet is a CNC tool for cutting 2D profiles from any flat material. A 2D CAD model with the filetype .dxf is uploaded, and a cutting path is generated. Then, after setting the material properties, the machine cut dimensions and the height, the waterjet will blast a water-abrasive mixture at 40K psi at the material, and cut out the shape.
[bookmark: _qxgds4w6uyo3]Physical Limitations:	
The bed size is 20 inches by 40 inches, but it is recommended that the workpiece not reach anywhere near the boundaries of the cutting area.
This waterjet pressurizes to 40K psi, but also drops pressure as the cut proceeds, so stronger or thicker metals may take more passes.
The recommended thickness for the Flow is 0.25 inches or less.
[bookmark: _or8ksgnfiqjk]Materials:	
A wide variety of materials are safe to cut with the Flow, however, it is important to consider the following:
Glass is specifically prohibited, as the Flow does not have a low pressure setting appropriate for brittle materials.
Wood tends to swell and become softer as it gets wet, so it may not cut as accurately.
Thicker and harder metals are harder to cut with the lower pressure waterjet.
Non-rigid materials are more difficult to hold down and tend to move during the cut.
[bookmark: _noo2flmw3ido]PPE:
Closed Toe Shoes
Safety glasses.
Flow splash guard.
Ear protection, if desired.
[bookmark: _8vdck13jgmay]E-Stops and Safety Procedures:	
Two E-Stops: One on the computer monitor, and one on the left of the machine, right next to the cascading water tanks. Large red buttons.
Always make sure the splash guard is down before making a cut.
Always stand by the computer during the cut to hit the pause or stop button in case the cut fails.
Make sure the garnet hopper and pump are de-pressurized before performing any maintenance.
Keep a mop nearby and clean up any spills so that passersby do not slip.
Be careful when handling rusty weights or when handling the sharp slats on the waterjet bed
Keep fingers away from the nozzle.
Make sure there is another person within yelling distance when operating the machine.
 
The top circle is the E-Stop
The middle circle is the hatch to the power rocker switch
The bottom circle is the Handle to the garnet hopper
Project Ideas (with links to content):
Making a sign out of fluted aluminum:
http://www.instructables.com/id/How-to-Waterjet-a-Sign-Out-of-Fluted-Aluminum/ 

Making gaming dice from folded waterjet parts:
http://www.instructables.com/id/Gaming-dice-made-from-waterjet-cut-steel-sheet-fol/ 
Note: instead of welding at the end, using epoxy or JB Weld will work fine.

Wall-mounted rivet fish:
http://www.instructables.com/id/Rivet-Fish/ 
[bookmark: _qckmg586rlc4]Startup Procedure:	
1.	Walk behind the flow on the side with the cascading pumps and open the hatch behind the cutting bed. Make sure the green power light is on. If not, click the Power rocker switch once to activate it.
2.	Turn on the pipes for water and air by turning the yellow handle such that they are parallel to the tubing.
3.	Pressurize the garnet hopper by turning the pipe on the garnet hopper such that it is perpendicular to the tubing. Then, pull up on the handle at the top until it stays there and the hole is plugged.
[bookmark: _u0sm9rlh6dmu]Operation of Equipment:
Note: for the software uses below, it is helpful to view the attached reference files to navigate the FlowPath and FlowCut interface
1. Upload design to computer. 
2. Open FlowPath software, and click File > Import and import the .dxf file.
3. Click the select tool in the upper right corner, and drag a window around the model. 
4. Click the move button in the left panel and click and drag to move the model such that it fits completely on the grid.
5. Click the Purge button on the right side menu to clean the diagram of dots and open contours.
6. With the whole model selected, click on the desired cut speed in the bottom panel. A lower cut speed takes longer, but produces a higher quality part. Generally 60 should suffice.
7. Click on the tab button on the left panel and click on a location on the model to add a tab to it. Adding tabs is important for keeping the part held down. Do not skip this.
8. With the whole model selected, click the AP (autopath) button on the right side menu. This should generate lead ins and traverses. If this does not generate the desired path, go back to the model to identify and delete any open contours, loops or double lines where the path is failing. 
9. Once the path is created, click File > Export Path As and select .ORD. Save this new path file in the flashdrive or to the desktop.
10. Open the FlowCut software. Click File > Import  to import the newly generated .ORD file.
11. There are three buttons in the bottom panel. Click the left one. This is the cutting parameters. In the pop up menu, select the material, thickness, and any brittle settings. Accept the changes.
12. Select the middle button in the bottom panel. Do not change any of these parameters, and click OK. A path preview should be generated. This can be sped up or slowed down to view the path the machine takes.
13. Click the right button in the bottom panel.
14. At the bottom, there is a house icon in the middle of 4 directional arrows, click on the house. Make sure there are no weights in the cutting bed of the waterjet. Select “Go to Machine Home” and click OK
15. Now put the workpiece in the cutting bed, and use proper hold down techniques such as weights to prevent it from moving. Try to keep the weights near the edge of the workpiece so that the nozzle does not collide with them.
16. Using the arrow keys or directional arrows on the computer screen, navigate the nozzle tip to the desired starting XY location. Click on the house icon again and select “Set current position as user defined home.”
17. Use the crank handle at the top of the nozzle assembly to move the nozzle tip up and down. Use the provided spacer to keep the tip a safe distance from the workpiece. The spacer should barely slide between the workpiece and the nozzle tip.
18. Verify that the nozzle will not collide with any weights or the workpiece as it traverses the cut by moving the nozzle with the computer arrow keys. Raise or lower the nozzle tip spaced to the highest point across the workpiece.
19. Close the splash guard
20. Click on the house icon and select “Go to User-Defined Home”
21. Click the green button next to Pump to turn on the water pump. Allow the pressure to rise to above 40 on the dial behind the waterjet.
22. Once it does, Click on the blue play button above the Pump button. This will start the cut.
23. Stand by the computer at all times during the cut in case it fails. If it fails and sprays water everywhere, click the pause button or hit the E-Stop if it is more serious.

[bookmark: _daa9ksk70ca2]Recommended Clean-Up:	
1. Make sure both water and air are off, and the garnet hopper de-pressurized. Do this by turning the yellow handles on the piping perpendicular to the piping.
2. The flow tends to spill a lot of water. Use a mop to clean up any water on the ground and use a shop towel to clean up any water on/near the computer.
3. When cleaning off the part, use the garden hose to spray the excess garnet off the part and into the cutting bed. Do not clean the part off outside the waterjet as it will drop garnet everywhere.
4. If any clamps or weights were borrowed, be sure to return them to their original location.

[bookmark: _uouloguaov96]Basic Troubleshooting:
1. If the path is not generating well in FlowPath, try pathing the model in Omax Layout first, then importing that into FlowPath.
2. If the Auto path is having difficulty finding a start point, draw a traverse line from the origin of the grid to a close point on the model.
3. If lines are skipped over during the pathing, zoom into them and make sure there are no double lines.
4. Worst case, assign a manual order path by clicking on the Preprocess > Manual Order Path and selecting the direction of cut at every intersection.
[bookmark: _j9hpp85vkhv]Advanced Troubleshooting:
1. If the water is not cutting, try increasing the thickness of the material.
2. To clean garnet clogs, depressurize the garnet hopper, remove the rubber feeding tube to the nozzle, and gently use the compressed air to remove stuck garnet.
3. If the pressure drops too low during the cut, stop the pump. Engage, then disengage the E-Stop, then turn the power back on using the instruction from Startup
4. Any more advanced clogs and pressurization issues should be reported to the Master or Apprentice. 



[bookmark: _gmo4s0dr7z25]Maintenance References:
https://www.filepicker.io/api/file/gmT6tjTT8u8GhGNotaY2 

https://digitalmedia.architecture.yale.edu/sites/default/files/files/fabrication/waterjet-basic.pdf 


[bookmark: _w293lh6cxogw]AJet
[bookmark: _eys7ut8u3j4b]Author:
Walker
[bookmark: _rarnu93eht54]Name of Machine:
Omax A-Jet

[bookmark: _f6w9idiabwc]Link to Manufacturer’s Manual:
[https://www.omax.com/sites/default/files/media/specsheets/omax-a-jet-600050b_0.pdf] 
This is a brief overview manual, as the full-length manual is proprietary and not available online. A paper copy of the full manual is available in the waterjet cabinet next to the Maxiem Waterjet

[bookmark: _rz8d42tm2bc2]3 Sentence Description (Explain Like I'm 5):
The A-jet is a 5-axis feature of the Maxiem waterjet that allows the cutting head to tilt and rotate to cut parts at precise angles. This can be used to cut a beveled/chamfered edge, countersink a hole, or create even more complex geometry (as shown in pictures below). The A-jet is a great way to make complex 3D parts quickly and accurately out of a wide range of materials from wood to plastic to metal. 

[bookmark: _wymf4ghsm3xt]Physical Limitations:
· The A-jet tilt angle cannot exceed 60o with respect to the vertical
· Maximum thickness of cutting for the A-jet is 2 inches
· All other physical limitations of the Maxiem 1515 still apply
· The kerf on the jet is 0.021 inches


[bookmark: _7ge5hjjkcrzd]PPE:
Safety glasses and closed-toed shoes are required for all waterjet cuts. Ear protection is recommended for A-jet cuts, especially when cutting metals, as the piercing process can be very loud.

[bookmark: _wnc2kvdnefox]E-Stops and Safety Procedures:
There is an e-stop on the controller connected to the waterjet cabinet, as well as one on the waterjet pump itself. There is also a digital pause button on the computer through the OMAX Make software when a job is running (this can also be activated by hitting the spacebar). Make sure to clamp the material down firmly before cutting, and do not under any circumstances put your hands near the cutting head while a job is running. 

Important Safety Note: PIs must pass the A-jet test (given by the Waterjet Master) to be able to use the A-jet

[bookmark: _389xmnjp3mjs]Project Ideas:
https://www.youtube.com/watch?v=kK4HthSdLoE
1. Cut a precise, complex turbine out of aluminum or steel
a. https://www.youtube.com/watch?v=AWoBKAUw8hQ (this is cut using another 5-axis waterjet that works the same as the A-jet)
b. An example of such a turbine cut using the Invention Studio A-jet is shown in the display cabinet in the space. The file that was used for cutting this part is available on the waterjet computer!
2. Inlay 1 part inside another using complementary bevelled cuts
a. Here is a visual of the finished product
b. This inlay was created by making a 45o bevelled cut on the outside of the metal chessboard, and making a 45o bevelled cut of the same size on the inside of the wood piece. This created a snug fit between the two parts made possible by the bevelling capability of the A-jet
c. This board is also available to view in the Invention Studio Display Cabinet
3. OMAX Example Files
a. There are a ton of cool A-jet ready files already on the waterjet computer provided by OMAX!
b. Scan through all the files and cut one or several that look cool!

[bookmark: _7p2e4uf3yjiv]Startup Procedure:
The startup procedure for the A-jet is the same as that of the Maxiem 1515 waterjet as far as turning the machine on and starting the software component, with only a few added steps. These steps are to enable the A-jet in the OMAX Make Software (described in more detail in the “Operation of Equipment: Setting up in OMAX Make” section), and replace the garnet feed tube with the correct one for the A-jet (described in more detail in the “Operation of Equipment: Setting up the cutting head for A-jet” section).
[bookmark: _blgljd8zva79]Operation of Equipment:
· Creating the File
· Create the 3D path file for the A-jet either by scanning a 3D model such as a solidworks part or .step file, or by creating the 3D data manually using OMAX Layout
· Set up the file like you normally would in OMAX Layout, but save it as an .OMX path rather than  a .ORD path; this will preserve the 3D data you just created
· Export this .OMX path the OMAX Make for cutting
· Setting up in OMAX Make
· When you are on the material selection page, select the correct material and thickness, and check the box on this page that says “Enable A-jet”
· When you get to the standard OMAX Make page, set up the cut like you normally would, but make sure you Square the A-jet, but not until you complete the “Setting up the cutting head for A-jet” steps below. You will be prompted to square the a-jet at the start of cutting, make sure there are no weight or clamps close to the cutting head when this occurs. 
· Setting up the cutting head for the A-jet
· First, remove the garnet feed tube that goes from the garnet hopper directly to the cutting head. Take the same-sized tube that is attached to the back of the cutting head assembly and place the end into the cutting head where the previous tube went. Take the long tube garnet tube that is pushed inside the vertical black cylinder next to the garnet hopper, and place the end of that tube into the bottom of the garnet hopper
· Ensure that the tube you just installed is dry by running compressed air through it for a few seconds
· Raise the z-height of the head, and remove the yellow splash guard that is used to reduce splashing. This should be replaced by the porous grey foam hexagon located in the waterjet cabinet
· Zero the z-height as you normally would, and check the entire spatial envelope of you path for potential collisions with the material or other items
· Set up the rest of the job like a normal waterjet cut on the Maxiem 1515, making sure to make multiple dry runs to ensure that the path is correct and that there are no potential collisions or hazards. Try to get the water level at least 1 inch above the part, as the a-jet can create big splashes!
· When you are done with the A-jet
· When done, please replace the garnet feed tube with the standard one previously in the machine, and return the a-jet garnet tube to its original state
· Please go back into the material setup page of OMAX Make and uncheck the “enable A-jet” box
[bookmark: _ujiywes5rnu]Recommended Clean-up
· While the above steps in the “When you are done with the A-jet” section are mandatory, the following are heavily recommended
· Follow the standard procedure for cleanup of the Maxiem 1515 waterjet, unclamping your material, cleaning it with water and compressed air, etc. (See the article on the Maxiem 1515 for further detail)
· Close OMAX Make and don’t forget to remove your flash drive from the waterjet computer!
[bookmark: _fyen6ioy88hh]Advanced Troubleshooting/Maintenance
· If there is a huge splash and the part is not being cut through all the way
· Check to ensure the material and thickness are set up correctly
· If so, ensure that garnet is flowing through the feed tube. If it isn’t, disconnect the feed tube from the garnet hopper and nozzle and dry the tube out with compressed air. 
· If garnet is still not flowing, run an abrasive only test (under the test section of OMAX Make) and ensure the solenoid below the garnet hopper is opening properly. If it is not, run the test again and try and clear out the solenoid with compressed air while it is open. 
· Afterwards, remember to reconnect the abrasive tube to the garnet hopper and nozzle.
· If the machine is faulting when you square the a-jet
· Make sure the z height is not close to the max height when you start the squaring process; this will cause it to fault. 
· Make sure there are no collisions or impeding forces (such as a garnet tube wrapping around the head during squaring) that might cause the machine to fault
· If nothing is happening when you square the a-jet
· Fully reboot the waterjet including the power switch
· If the a-jet is bevelling the wrong way
· Go back into OMAX layout, reverse the direction of the bevel by changing the sign of the bevel angle (+/-)
· Resave the .OMX path and reopen in OMAX Make




[bookmark: _oagteiuujj0h]References:

“Omax A-Jet Image.” Headland, 16 Aug. 2018, 
www.headland.com.au/superior-abrasive-waterjet-technology-changing-the-stone-industry/omax-a-jet/.

“Omax A-Jet Manual.” Omax.com, Maxiem , Jan. 2014, 
www.omax.com/sites/default/files/media/specsheets/omax-a-jet-600050b_0.pdf. 

Accurl Machining Tools. “5D 5 Axis Waterjet CNC Machine | CNC Water Jet Cutting Machine | 
Thick Metal Cutting.” YouTube, YouTube, 11 Oct. 2016, 
www.youtube.com/watch?v=AWoBKAUw8hQ. 

[bookmark: _gwed8ws36yz3]Etching Using Images
[bookmark: _b59cup4czjya]Author: 
Walker
[bookmark: _abz3imnnvpqn]Name of Machine: 
Etching Using Images
 

[bookmark: _7yc9sndgdiva]3 Sentence Description (Explain Like I'm 5):
The image etching feature of the Maxiem 1515 waterjet is the process of engraving an image into metal. You provide an image file such as a .jpg or .png, and software on the waterjet computer interprets the image, converting it into a path that the waterjet follows to reproduce the image on the metal. This feature is perfect for engraving aluminum with a wide array of designs and patterns!

[bookmark: _g00zpni2ylzt]Physical Limitations:
· Cannot engrave any material thinner than ⅛”
· Material cannot be flexible
[bookmark: _xrq4mbb80cu8]PPE: 
Safety glasses and closed-toed shoes are required for all waterjet cuts. 
[bookmark: _jiwvmxgt1oqy]E-Stops and Safety Procedures:
There is an e-stop on the controller connected to the waterjet cabinet, as well as one on the waterjet pump itself. There is also a digital pause button on the computer through the OMAX Make software when a job is running (this can also be activated by hitting the spacebar). Make sure to clamp the material down firmly before cutting, and do not under any circumstances put your hands near the cutting head while a job is running. 
[bookmark: _u593nsx1wdtr]Project Ideas: 
1. Engrave a chessboard into aluminum
a. https://i.imgur.com/Ln4fIpm.jpg Here is a visual of the finished product
b. The image provided for this cut was a simple grid of 8x8 black and white squares shown here https://imgur.com/F0hPm2d 
c. This board is also available to view in the Invention Studio Display Cabinet
2. Engrave a picture of any cool thing you can find
a. Find a good image on the internet (preferably black and white as that produces the best results) and engrave it!
b. This particular image is a sample provided on the waterjet computer. That and several other samples are great ways to experiment with the software.


[bookmark: _9uhu6goghjh5]Operation of Equipment
To set up an engraving
· First, bring the desired image on a usb stick and plug it into the Maxiem 1515 computer. 
· Next, open up Omax Intelli-Etch, a program that should be on the quick launch menu of the computer
· From there, you use the software to select your desired image 
· Follow the on screen instructions to set the contrast and colors of the image
· Keep in mind that darker sections of the image will engrave more deeply, while lighter pixels will engrave more shallow
· If there is a border part of the image that you want to ignore, select it in the color border segment and it will not be engraved
· Once the image is set up, adjust the speed of the cut
· The way the process works is the waterjet operates at constant (either high or low) pressure, and goes back and forth along the envelope of the image. The depth of the engraving is controlled by how quickly the head moves. It will travel faster on lighter pixels to engrave less deeply, and slower on darker pixels for the opposite effect. As such, increasing the minimum speed will decrease the depth of darker pixels, while decreasing the maximum speed will increase the depth of lighter pixels.
· In addition to the speed, you must either high or low pressure. Use lower pressure for soft materials like aluminum, and use high pressure to engrave stronger materials such as steel. 
· Once the colors, speeds, and image are selected, the software will export the path to Omax Make. The job will be displayed as a large red rectangle defining the outer dimensions of the desired engraving. 
· Set up your part like a normal waterjet cut, but raise the z height 1 cm or so above where it would typically be. Ensure there are no collisions, make sure you have plenty of garnet in the hopper and auto-feeder, and run the engraving.


[bookmark: _nrsx5p8mt4r0]Advanced TroubleShooting:
· If there is a fault in the middle of the cut
· It is likely due to garnet buildup on the surface (as it does not go all the way into the tank with an engraving). To solve this, it is good to use the water gun to spray some of the garnet off of the surface while the cut is going on. Make sure to keep all extremities away from the cutting area though.
· After resetting the fault, try and line the head up right where the fault occured to continue engraving the same image.

[bookmark: _59me4jtbttpj]References:

“Omax IntelliEtch Image.” OMAX Waterjet Cutting Machine Manufacturer, 2018, 
www.omax.com/software/tools#etch.

Richter, Alan. “Omax Butterfly Image.” Cutting Tool Engineering, 1 Mar. 2017, 
www.ctemag.com/news/articles/enter-matrix. 



[bookmark: _glkuriqbo9vo]OMAX Make
[bookmark: _h3zz06cqicg8]Author: 
Miles
[bookmark: _md5y9isgukpu]Name of Machine: 
OMAX and ProtoMAX Make

[bookmark: _t507vt49f3gb]Link to Manufacturer’s Manual:
https://knowledgebase.omax.com/protomax/content/wh-protomax/make/overview_of_make_software.htm

Picture of Tool in Space:
 

[bookmark: _9rfc6jteo31t]3 Sentence Description (Explain Like I'm 5):
The OMAX and ProtoMAX Make softwares (henceforth referred to as “Make software”) are used to run waterjet jobs prepared in the Layout softwares. The Make software provides controls for homing, nozzle testing, nozzle movement, and defining material settings. The Make software also displays relevant statistics such as job time, and system faults if present. 

[bookmark: _owka13jxhq3g]E-Stops and Safety Procedures:
The E-stop for the Maxiem is on the right side of the waterjet computer stand. When running a job, the Make software can be paused by hitting the spacebar or clicking the “Pause” button on screen. When running a nozzle test, the test can be stopped by clicking the “Cancel” button. The Make software displays current system faults or conditions, and does not allow for operation in certain situations. Specifically on the ProtoMAX, cutting will not occur when the cover is open.

 
[bookmark: _yzsd9d17qdrl]Startup Procedure:
1. Verify that the USB cord from the waterjet is connected to the computer.
2. Click the Make software icon on the computer desktop.
3. [OMAX Only] Press the black and green buttons as labeled on the control box on the right side of the waterjet computer stand to clear motion faults
4. [ProtoMAX Only] Clear the waterjet bed of clamps and scrap material.
5. [ProtoMAX Only] Home the machine by clicking the red bar.
6. At this point, all controls should be available for use

[bookmark: _wl6zygrt2y2v]Operation of Equipment:
Loading a job from computer
1. Click “Change Path Setup”
2. Navigate to the .ORD or .OMX file describing the cut, as shown in the figure.
3. Set material properties in this dialog
4. [Maxiem Only] If this is a brittle material cut, follow steps outlined in the Brittle Material article
5. [Maxiem Only] If this is an A-Jet cut, follow steps outlined in the A-Jet article

Loading a job from OMAX Layout
1. [ProtoMAX Only] In Layout, right click “Post” and click “Open OMX Path in MAKE”
2. [Maxiem Only] In Layout, right click “Path Setup” and click “Open ORD Path in MAKE” for a regular 2D profile, and “Open OMX Path in MAKE” for an A-Jet cut
 
Changing material settings
1. Click “Change Path Setup”
2. Set material properties in this dialog
3. [Maxiem Only] If this is a brittle material cut, follow the steps outlined in the Brittle Material article
4. [Maxiem Only] If this is an A-Jet cut, follow the steps outlined in the A-Jet article

Displaying job statistics
1. Navigate to “Statistics” tab on right side of screen as shown in figure.
2. Statistics include material settings, estimated cut time, estimated abrasive needed, number of pierces, dimensions of cut, and length of cut.

Moving the nozzle
1. Ensure that “Num Lock” is on, or the keyboard will not work
2. X and Y Direction: Use the keyboard arrow keys to move the nozzle in the X and Y directions.
a. [ProtoMAX] X direction is along the front of the machine
b. [Maxiem] X direction is along direction of large gantry motion
c. [ProtoMAX] Y direction is along the right or left side of the machine
d. [Maxiem] Y direction is along the long dimension of the ballast tank at the rear of the machine
3. [ProtoMAX Only] The nozzle is moved manually per the directions in the ProtoMAX article
4. [Maxiem Only] Rapid Z direction: Use the “Pg Up” and “Pg Dn” buttons to move the nozzle up and down in the Z direction rapidly.
5. [Maxiem Only] Fine Z direction: Use the “Home” and “End” buttons to move the nozzle up and down in the Z direction in small amounts.


Setting the home position
1. Move nozzle to home position in X, Y, and Z directions
2. To zero X and Y directions, click the “Zero” buttons to the left of the “Distance to Home” and “Distance from Path Start” values
3. [Maxiem Only] To zero Z direction, click the “Zero” button to the left of the Z position display

Go to Home Position
1. To go to home position in X and Y dimensions, click “Go home” button to the right of the “Distance from User Home” and “Distance from Path Start” values
2. To go to home position in Z dimension, zero Click “Go home” button to the right of the Z position display


Key View Controls
1. Examples: Zoom Cursor, Pan, and Zoom Extents buttons are in bottom right of screen
2. Hover over buttons to find out what they are
3. Zoom Cursor: zoom in on area of part display
4. Pan: pan around part display
5. Zoom Extents: display entire part in part display

Dry Run
1. Raise the Z axis at least 1 inch
2. Check that cut path is clear of clamps, weights, and other obstacles
3. Move nozzle to X-Y home position
4. Click “Begin Machining”
5. Right Click “Start” and select “Dry Run” at whatever speed you prefer
6. Machine will follow cut path, with water and garnet flow off

Go to Spot on Path
1. Raise the Z axis at least 1 inch
2. Check that straight path from current nozzle position to spot is free of clamps, weights, and other obstructions
3. Click “Begin Machining”
4. Right Click “Start” and select “Go to Spot on Path”
5. Click spot to go to in black path display
6. Machine will rapid over to selected spot

Running a Job
1. Move nozzle to home position in X, Y, and Z directions
2. Visually check that cut path is free of clamps, weights, and any other obstructions
3. Click “Begin Machining”
4. Click “Start”
5. Cut will run until it is finished, and 

Pulling Pump Hours
1. At top of display, click on “History” and navigate to “Counters/Timers”
2. Record number listed to the right of “Total hours on pump”

[bookmark: _crht59g6x4f]Recommended Clean-Up:
Close the Make software using the “x” button in the top right hand corner of the display. Remove flash drive from waterjet computer. Always remember to spray down the waterjet cutting area and L-bracket to remove built up garnet when finished.

[bookmark: _v43m3fbsnz34]Basic Troubleshooting:
· Clearing faults
· [ProtoMAX Only] On the right side, click “Status” and select fault. Follow on screen directions to clear fault. 
· If you do not understand the fault, contact a waterjet master because it may be an important fault
· [Maxiem Only] Press green and black buttons on box on the right side of waterjet computer stand to clear fault.
· Fault will not clear
· [Maxiem Only] Check whether E-stop button is released. A yellow ring should be visible if the E-stop is released. To release the E-stop, turn the red button in the direction of the arrows and the red button should release and snap upwards.
· [Maxiem Only] Press green and black buttons on box on the right side of waterjet computer stand to clear fault.
· If following on screen directions do not resolve the fault, contact the waterjet master
· Nozzle does not move as commanded
· Check that motion faults are cleared
· [ProtoMAX Only] If nozzle position controls appear faded on screen, machine homing may not have been done. Check for red bar at the top of black part display and follow the on screen directions.
· If the problem remains unresolved, close and reopen application. If a communication error occurs, check the connection between the waterjet and computer.
· If all else fails, reboot the machine and computer
· Communication error shows up
· The waterjet and computer may not be communicating properly. Check the USB connection
· If the USB connection seems secure, reboot the computer.
· If rebooting the computer does not fix the issue, reboot the entire system including the computer


[bookmark: _60fm0dcqhwfv]Advanced Troubleshooting/Maintenance:
· The Make software registration needs to be updated regularly. A notice appears when there are 30 days left on the registration period. Clint should be informed so he can contact OMAX. The new registration key will be sent shortly thereafter and applied to the computer. This requires advanced computer privileges, which the waterjet masters have.
· If communication issues persist, the waterjet master may have to verify that the USB ports on the computer remain functional. Sometimes, rough usage results in the USB ports becoming damaged, and a new computer should be requested if there are insufficient ports to deal with the issue
· If faults persist, the waterjet master needs to deal with issues on case by case basis, using instructions presented in manual and on OMAX Knowledgebase.
[bookmark: _abtweay9j381]References:
OMAX. (n.d.). OMAX MAKE Software. Retrieved on July 8, 2018 from https://www.omax.com/software/make 




[bookmark: _o50j6is0xjrx]OMAX Layout
[bookmark: _i7g3pzbqenyr]Author:
Sid
[bookmark: _xje5mu9gfv7f]Name of Machine:
Omax Intelli-Max Layout

[bookmark: _e8nxw01kuvgy]Manufacturer’s Manual:
https://knowledgebase.omax.com/protomax/content/wh-protomax/operatortraining/usinglayoutsoftware.htm 

Picture:
 

[bookmark: _drr8bzbezhig]Description:
Omax Layout is a 2D CAD software that creates toolpaths for Omax Waterjets. Layout provides the tools necessary to import 2D CAD files, such as .dxf, and process them for use with the Omax Maxiem 1515 and Protomax waterjet. Some of these tools include cleaning imported files for pathing errors, generating toolpaths, detecting defects and dangerous features, and even drawing extra shapes to supplement the cut.

[bookmark: _dc20tsqgx6el]Startup:
Click on the Omax layout icon in the taskbar at the bottom of the monitor and click  File > Import  and select the desired file.

Find the desired file using the File Explorer, right click, and select Open With Omax Layout.

[bookmark: _gzl0zpjsshi0]Operation:
Note: for the software uses below, it is helpful to view the attached reference files to navigate the Omax Layout interface
1. Open the desired file(s) in Omax Layout using the startup procedure above. Make sure the file type is .dxf
2. On the right menu bar, click “Clean.” On the pop up menu, make sure “Remove Unnecessary Dots” is selected. Then click “Start”.
3. For reference, each grid square is 1 sq. inch; use this to determine whether your part is the right scale. If not, right click on the “Select” button in the upper left bar, and “Select All.” Then click on the “Size” button in the same menu bar and enter the scale factor.
a. Note about the Select Tool: The default selector selects single lines. To select a    window, right click on “Select” and click on “Window.”
4. If the file is not fully on the grid, Select all using the instruction above, and select the “Move” button to move the model. Click and release on the model, this defines a starting location. Do not click and hold the mouse button. Then click and release on the final location; Layout should preview the final location on the model as you do this.
5. Rotate the files by selecting the model to rotate and using the rotate button. Again, click and release on the model for the initial position, and click and release for the final position. A numerical angle can also be specified in the menu that appears on the bottom of the screen.
6. Right click on the quality button on the bottom menu bar and click on “All.” Select the desired cut quality. 5 is the highest quality of cut, but also takes the longest. Generally, 3 should suffice for most cuts.
7. Right click on “Lead I/O” and select “Autopath (Advanced and Configure).” On the diagram to the left, select the starting and ending points. The green dot is the start, while the red dot is the terminus. Then click OK.
8. Green traverse lines and small orange lead in/outs should have been generated. 
9. Right click on “Lead I/O” and select “Create tab”. Hover the cursor near the desired location of the tab. When the tab appears, click to secure its location.
10. Right click on “Path.” In the right menu bar. Select “Automatically generate.” On the pop up diagram, Click on/near the starting point.
11. The path should automatically generate and a preview should appear. If there are errors, please refer to the Troubleshooting section below.
12. Make sure that the kerf of the path is on the correct side of the cut lines. If not, then reject the path and make sure the model is clean. If the problem persists, please refer to the Troubleshooting section below.
13. If the path is correct, click Save. Then right click on “Path” and open ORD path in Make. 
14. Continue the process in the Make software.


[bookmark: _7hpvmai9zhsx]Basic Troubleshooting: 
1. When creating files for use with the waterjet, make sure the filetype is .dxf. Other 2D CAD files do not work as well with importing.
2. When generating .dxf files, good practice is to use CAD software to fully define the edges first. This helps eliminate discontinuities, loops and other defects. If using a vector design software, like inkscape. Make sure any corners or junctions between lines are fully connected and smooth (no loops).
3. In the “Clean” diagram menu, increase or decrease the threshold to either include smaller features, or delete larger ones.
4. If the path still appears on the wrong side, right click on the “Path” button and select Custom Toolpath options. In the pop-up diagram, select the Kerf offset and accept the changes. Then try re-pathing the model.
[bookmark: _lctjrs3y330k]Advanced Troubleshooting:
1. Zoom in where the errors occur, if the error is a loop, use the selector tool to delete the loop and clean the diagram again. 
2. If the error is a disconnect, use the line tool to connect the discontinuity.
3. If the error is the kerf offset on the wrong side, and basic troubleshooting did not work, use draw a box around the model, and set a cut quality of 3. Then repath.
4. The last manual solution is to click Path > Custom Toolpath Options. Then select “ask me at each opportunity” to run through the cut and manually select the kerf offset. 
5. For additional preprocessing, open the file in a 3D CAD software such as Fusion 360, and make sure the paths are fully defined.
[bookmark: _gwkmt23iqv0d]References:
Omax. (n.d.). Omax Layout. Retrieved July 7, 2018 from https://knowledgebase.omax.com/protomax/content/wh-protomax/layout/help_contents.htm 

Omax. (n.d.). Omax Layout. Retrieved July 7, 2018 from https://www.omax.com/software/layout 


[bookmark: _hpupfd7kq2jf]Garnet Autofeeder
[bookmark: _pcth61wq88gj]Author: 
Walker
[bookmark: _jlt4yfxtbe7z]Name of Machine: 
Garnet Autofeeder
[bookmark: _hloydffk183]Link to Manufacturer’s Manual:
[https://www.omax.com/sites/default/files/media/specsheets/600051a_-_bulk_abrasive_delivery_system_0.pdf]  
This is a brief overview manual, as the full-length manual is proprietary and not available online. A paper copy of the full manual is available on top of the garnet autofeeder

[bookmark: _e4s0e1gq704l]3 Sentence Description (Explain Like I'm 5):
The garnet autofeeder is a pressurized tank that holds up to ten 55lb bags of abrasive garnet. Garnet is the sand-like material that a waterjet mixes with its high pressure stream of water to allow the machine to cut through strong materials like metal. The autofeeder ensures an uninterrupted supply of garnet to the cutting head of the Maxiem 1515 while the waterjet is running.

[bookmark: _tt46qynds7ok]Physical Limitations:
· Cannot hold more than 10 bags of garnet in from an empty tank
· Must operate between 90 and 125 psi inlet air pressure

[bookmark: _c39qweufiwdw]PPE:
Safety glasses and closed-toed shoes are required around waterjets, where this machine will be. Wearing safety glasses while refilling the autofeeder is important, as the pressurized tank might spray small amounts of garnet when opened even if it has already been depressurized.  

[bookmark: _tk11vcz0dc1b]E-Stops and Safety Procedures:
If there is an issue in the tank, such as garnet being sprayed into the room if a hose comes undone, you can stop the machine by closing the global air inlet (connected to the wall near the tank), or closing the local air inlet (The valve half-way up the tank on the left side with the gray hose attached). You can also close the outlet valve at the very bottom of the tank connected to the clear hose to prevent garnet from leaving the system.

[bookmark: _xqlxlx9o1xgq]Operation of Equipment
To refill the tank if it is empty or low on garnet:
· First depressurize the tank
· Make sure the inlet air valve (located halfway up the tank connected to the grey hose) is closed, as well as the outlet valve underneath the tank connected to the clear hose. 
· Open the air release valve towards the top of the machine (connected to the metal cylinder with holes in it) and wait for air to stop flowing out of the tank. You should hear the stopper under the lid fall down into the tank
· Next, fill the tank with garnet
· Get 5-10 bags of garnet (depending on how full the tank is) from the basement. It is best to find a cart to carry it all.
· Get a box cutter from the cabinet in the room
· Take the lid off of the tank, and one by one cut open each bag with a boxcutter and pour its contents into the top of the tanks, guiding it through the center hole. The boxcutter is to prevent unwanted plastic in the bags from contaminating the tank
· Once you start to see garnet appear towards the top, stop adding more bags
· Finally, pressurize the tank
· Close the pressure release valve
· Grab the stopper in the top of the tank and pull it up so that it is flush with the hole. While holding it there, open the pressure inlet valve and pressurize the tank, this should keep the stopper in place
· Put the lid on top of the tank
· Open the garnet outlet valve at the bottom of the tank and watch garnet flow towards the jet
[bookmark: _2fhf1wo6eqt0]Recommended Clean-up
· After refilling the tank, or otherwise working with the autofeeder, there will likely be some garnet either on the ground below the tank and/or on the tank itself. Please wipe down the tank with a brush/dustpan, and clean up the floor with a broom. Use the trash can in the room to dispose of the dirty garnet.
[bookmark: _yeuxsdvv5fmp]Basic Troubleshooting
· If the hose disconnects at the bottom of the tank and garnet is spraying, close both the air inlet valve and the outlet valve at the bottom of the tank as fast as possible, then clean up all the garnet that just spilled! If you can, push the hose back into the fitting at the outlet of the tank while outlet valve is closed, if you are having trouble getting the tube back on the fitting, contact the waterjet master for assistance.
· If the hose is causing garnet to go crazy and spray out of the small hopper on the water jet itself, that means there is no more garnet in the tank and the autofeeder is just spraying air into the small hopper. Close the outlet valve and follow the procedure above for filling the tank
[bookmark: _roytsukats6q]References:
“Bulk Abrasive Hopper.” Waterjets.org, 2018, 
waterjets.org/archive/buyers-guide/general/advice-on-specific-components/. 

“Omax Bulk Abrasive Delivery System.” Omax.com, 2015, 
www.omax.com/sites/default/files/media/specsheets/600051a_-_bulk_abrasive_delivery_system_0.pdf. 







[bookmark: _wlmpr1vbesjn]Hold Down Techniques (Waterjet)
Author: NONE
[bookmark: _rmzjafur5i8a]Brittle Materials
[bookmark: _20e4uqw4stbv]Author: 
Walker
[bookmark: _i2huojhn9nd3]Name of Machine: 
Brittle Materials

 
Image Source: Water cutting machine blog

[bookmark: _wzdn8lksos5w]3 Sentence Description (Explain Like I'm 5):
When cutting brittle materials on the waterjet, lower pressure settings and fewer piercing operations go a long way towards ensuring a successful job. Oftentimes, the brittle material should be secured on a sacrificial material such as a waterjet brick, which protects the part better than directly clamping the brittle material on the waterjet slats. Every brittle material job is different, and should be approached with great care using the guidelines provided in this article and the OMAX Maxiem 1515 article.

[bookmark: _4ncwqg3d4vla]Physical Limitations:
· All physical limitations of the OMAX Maxiem 1515 Waterjet apply.
· If the brick is used, subtract 6 inches from the maximum material cut height of 12 in.
· If other sacrificial material is used, subtract that sacrificial material thickness from the maximum Z-height of 12 in. to obtain the allowable material cut height
· Materials which are brittle and extremely tough should not be cut using the waterjet
· Example: tungsten carbide (a common material for waterjet nozzles, incidentally)
· Highly wear resistant
· Brittle - demands low pressure settings, worsening the issue


[bookmark: _42f6bws3zgd0]Materials:
· Glass (not tempered)
· Ceramics
· Porcelain
· Acrylic
[bookmark: _b8glt2ku4qpb]PPE:
Safety Glasses are required. Cut resistant gloves are required for handling materials with sharp edges, and fragments if shattering does occur.
[bookmark: _ciqo3htuxq8x]Project Ideas (with links to content):
· Cutting glass plate with bolt pattern and cutout
· https://youtu.be/b0prSmI2zZs
· Great example of waterjet brick usage
· Cutting bicycle pattern from ceramic tile
· https://youtu.be/5E4pxS22NlY
· Note usage of perforated, waterjet brick-like sacrificial material below the material being cut
· Marble tile carpets
· https://youtu.be/hpiMTM8K4WA
· Waterjet ability to cut intricate pieces of marble allows the creation of beautiful tiled patterns
· Cutting porcelain tile
· https://youtu.be/Ws0Jmh3Re30
[bookmark: _l13dljue2up7]Startup Procedure:
1. Follow the general OMAX Maxiem 1515 and Layout instructions.
2. It is highly recommended to design cut path so that piercing the material is avoided by starting the cut operation off the material.
3. When following the general OMAX Make instructions, be sure to select the “Very Brittle Material” setting.
4. Also, select “Low Pressure Pierce,” “Wiggle Pierce,” or another low pressure piercing option. 
[bookmark: _ddauqlurz7ta]Operating Instructions:
Use operating instructions as listed on the OMAX Maxiem 1515 article, making sure to follow the indicated steps for securing brittle materials. Using sacrificial material such as the waterjet brick is important for prevent frosting underneath the part and providing even support to minimize risk of cracking.
[bookmark: _ivma50lmwtmj]Recommended Clean-Up:
1.	Verify that any material fragments are retrieved from the tank and properly thrown away.
2.	Follow general clean up procedure for the OMAX Maxiem 1515

[bookmark: _51jt921iud44]Basic Troubleshooting/Maintenance:
Follow basic troubleshooting steps for the OMAX Maxiem 1515.
· If low pressure settings are active and material (ex. Glass) is still shattering
· Try to re-setup the cut so that the jet pierces off of the part, and allow it to edge cut onto the piece from the side, greatly reducing the chance of shattering.
· Check whether glass is tempered. Tempered glass is already under stress, and will shatter regardless of settings.


[bookmark: _u0xgd38dmuyu]Advanced Troubleshooting/Maintenance:
Follow advanced troubleshooting steps for the OMAX Maxiem 1515
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[bookmark: _w0r0h8qsnnf1]Saw Feature
[bookmark: _lyvwfhxjy48q]Author: 
Miles
[bookmark: _uhfcydd6tg61]Name of Machine: 
Saw Feature (Water Jet)

[bookmark: _adtvlbvt3cn2]Link to Manufacturer's Manual:
(https://knowledgebase.omax.com/protomax/content/wh-protomax/make/help_cut_off_saw.htm?Highlight=saw)

[bookmark: _ilwdzciff3ca]3 Sentence Description (Explain Like I'm 5):
The Make software contains a saw feature, which allows the user to define the distance and direction of a straight cut from the current position of the waterjet nozzle, using the current material settings. This is useful for cutting material stock into smaller pieces, for usage on smaller machines or other manufacturing processes. 

[bookmark: _b8f6widiq0gh]Physical Limitations:
· Waterjet physical limitations apply
· Saw feature does not pierce, so cuts must start off the material
· Kerf (width of material removed) on OMAX Maxiem is 0.021 in.
· Kerf on ProtoMAX is 0.015 in.
· Kerf is centered on cut line
[bookmark: _2m2zb3fnrqto]PPE:
Safety glasses, closed toed shoes required in machine shop.
[bookmark: _u0xpaz2k0w3h]E-Stops and Safety Procedures:
You can stop the Saw Function by:
· Hitting the stop button on the screen dialog
· [OMAX Maxiem Only] Hit the E-Stop
· [ProtoMAX Only] Open up the hood
· [ProtoMAX Only] Turn the main breaker to “off position”

[bookmark: _bozwcfdq87ne]Project Ideas (with links to content):
· Cutting an Anvil in Half
· https://youtu.be/quL14Csmi_Y?t=2m13s
· Safety Note: Please wear safety glasses in the work area
· Cutting Obsidian with a Waterjet
· https://youtu.be/hv3jeGUv9fY?t=4m18s
· Safety Note: Please do not place waterjet parts in contact with the mouth. The parts may not be sanitary.
· Cutting Gold with a Waterjet
· https://youtu.be/1mpdJcGj8Qg?t=2m35s


[bookmark: _vps3y9aycy32]Startup Procedure:
1. Turn on the waterjet
2. Secure the material
3. Open the Make software
4. Set the appropriate material settings
a. If these need to be modified later, click the “Change Path Setup” button
b. Modify the material properties in the dialog shown in the figure.

The detailed procedure for these steps on the Invention Studio waterjets is covered under the ProtoMAX or OMAX Maxiem articles.

[bookmark: _zye0261uyp6]Operation of Equipment:
1. Position the waterjet nozzle in the desired cut start position using the arrow keys. Please start the nozzle at a position off the material, and saw onto the material. Since the waterjet does not pierce when using the saw feature, starting off the material prevents any issues with material penetration.
2. In the Make software, click the “Saw” button to open the saw feature.
3. Define cut quality using drop down menu
4. Define direction using angle display dial or “Angle to cut” text box
5. Define distance along direction using “Distance to cut” text box
6. Raise water level to just above material if heavier than water
7. If material is buoyant, do not raise water level
8. Lower yellow splash guard
9. Verify sufficient garnet present to complete job
10. [ProtoMAX Only] Close lid
11. Click “Go!”
12. Dialog will automatically close when saw operation is complete
[bookmark: _wy6v1ewyo0gs]Recommended Clean-Up:
1. Rinse your pieces and remaining material over the waterjet tank
2. Blow dry your pieces and remaining material using the compressed air gun
3. Remove your pieces and remaining material from the waterjet and set aside
4. Choose whether to keep or discard remaining material in the scrap material area
5. Using the water nozzle on low throttle, shower setting, spray down the work area to remove accumulated garnet
6. [ProtoMAX Only] Empty garnet reservoirs if full


[bookmark: _wrj58u7isk9w]Basic Troubleshooting:
Follow basic troubleshooting steps for the machine in use (ProtoMAX or OMAX Maxiem)
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